
บทท่ี 5
สร ุปผลการดำเน ินการว ิจ ัยและข ้อ เสนอแนะ

กรุงเทพมหานครเป็นเมิองหลวงของประเทศที่มิการเจรืญเต็บโตอย่างรวดเร็วทั้งในด้านจำนวน 

ประชากรและวิทยาการด้านต่างๆ ล่งผลให้เกิดการอพยพประซากรจากทั้วสารทิศของประเทศเข้ามา 

อยู่อาลั'ย หางานทำและศึกษาต่อในกรุงเทพมหานคร โดยเฉพาะนิสิตนักศึกษาที่มีภูม ิลำเนาอยู่ต ่าง 

จังหวัดจำนวนมากได้เข้ามาศึกษาต่อในกรุงเทพมหานคร ซึ่งเป็นศูนย์กลางทางด้านการศึกษา ทำให้ 

สถานศึกษาไม่ลามารถจัดหาที่พักให้ได้เพยงพอกับจำนวนของนิสิตนักศึกษา อีกทั้งหอพักในสถาน

ศึกษายังมักพบปัญหาด้านบรํการพื้นฐานที่มิไม่เพยงพอและความแออัดของที่พ ัก จํงเป็นอีกลาเหตุ

หนึ่งที่ทำให้เกิดหอพักเอกชนขึ้นโดยรอบมหาวิทยาลัยหรือสถานศึกษา โดยเฉพาะในเขตที่มิสถาบัน

การศึกษาอยู่หนาแน่นอย่างเขตปทุมวัน เซ่น จุฬาลงกรณ์มหาวิทยาลัย โรงเรียนเตรืยมอุดม สถาบัน 

เทคโนโลยีราชมงคลวิทยาเขตอุเทนถวาย วิทยาลัยพยาบาลตำรวจ วิทยาลัยช่างกลปทุมวัน ซึ่งการหา 

หอพักให้ตรงกับความต้องการของนิสิตนักศึกษามิความจำเป็นอย่างยงต่อการใช้ชวิตขั้นพื้นฐาน

ระบบสารสนเทศทางภูม ิศาสตร์ เป็นระบบสารสนเทศที่มิการผสมผสานระหว่างข้อมูลกราทิเก 

และข้อมูลตามลักษณะเข้าด้วยกัน ระบบยังมิความสามารถพิเศษในการระบุตำแหน่งพิกัดที่ต ั้งลงบน 

แผนที่ได้และสามารถนำเข้า จัดเก็บ ค้นศึน แก้ไข ว ิเคราะห ์ แสดงผลของการวิเคราะห์ในลักษณะ 

ของข้อมูลกราทิเกและข้อมูลตามลักษณะ แสดงความลัมพันธ์ทางพื้นที่ของปรากฏการณ์ได้ดและแสดง 

รายละเอียดของสถานที่ได้โดยอาลัยข้อมูลตามลักษณะ ระบบสารลนเทศทางภูมิศาสตร์สามารถใช้

ในการจัดทำฐานข้อมูลหอพักทั้งข้อมูลกราทิเกและลักษณะประจำให้มิประสิทธ๊ภาพสูง อีกทั้งการ

ลอบถาม - ค้นคืนข้อมูลรายละเอียด การวิเคราะห์ค้นหาหอพัก เพื่อให้เหมาะสมและตรงกับความ

ต้องการของนิสิตนักศึกษาให้มากที่สุด และแสดงความลัมพันธ์ทางพื้นที่ของหอพักกับพื้นที่บรืเวณ

ใกล้เคยงให้เห็นได้ซัดในรูปแบบแผนที่เพื่อช่วยประกอบการตัดสินใจ

ในปัจจุบ ันมิการนำภาษาคอมพิวเตอร์ เช่น ปาสคาล โคบอล วิชวลเบสิกมาใช้ร่วมกับ 

ระบบสารสนเทศภูมิศาสตร์ในการจัดทำโปรแกรมประยุกต์ เพื่อสนองตอบความต้องการของผู้ใซได้

อย่างเต็มที่ เนื่องจากระบบสารสนเทศทางภูมิศาสตร์เป็นโปรแกรมที่มิความซับช้อนจึงไม่สะดวกใน

การนำไปใช้สำหรับผู้ที่ไม่มิพื้นฐานทางด้านนี้ จึงมิการนำภาษาโปรแกรมมาช่วยในการพัฒนา

โปรแกรมทางด้านภูมิศาสตร์โดยการเขียนโปรแกรมประยุกต์ระบบสารสนเทศทางภูมิศาสตร์ให้อยู่ใน 

รูปแบบที่ง่ายขึ้นทั้งด้านการนำเสนอและการใช้งาน

ผลการวิจัยและการวิเคราะห์ผลการดำเนินงาน รวมทั้งข้อเสนอแนะลามารถสรุปได้ดังนี้



92

5.1 ผลการดำเนินการวิจัย

5.1.1 ข้อมูลตามลักษณะ (Attribute data)

ข ้อมูลตามลักษณะ เป็นข้อมูลแสดงรายละเอียดของข้อมูลกราฟิกทั้งหมด ที่จำเป็นต่อการ 

ทำงานของโปรแกรมในการค้นหาหอพัก โดยฐานข้อมูลนี้จะมุ่งเน้นการจัดเก็บข้อมูลที่พักอาค้ยที่นิสิต 

น์กสืกษาสามารถเข้าพักอาลัยได้เหมือนหอพัก และข้อมูลอื่นๆที่ผู้วิจัยเห็นว่าน่าจะเป็นประโยชน์ต่อ

นิสิตนักสืกษาในการตัดสินใจเลือกเข้าพักอาลัยด้วย อีกทั้งฐานข้อมูลนี้ยังเป็นประโยชน์ต่อผู้ดำเนิน

กิจการที่พักในการสืกษาข้อมูลเพื่อใช้ในการปรับปรุงแก้ไขกิจการของตนเองต่อไป

5.1.2 ข้อมูลกราฟิก (Graphic data)

ฐานข้อมูลกราฟิกเป็นประกอบด้วยข้อมูลพื้นฐานต่างๆ ได้แก่

- แผ่นข้อมูลขอบเขต

- แผ่นข้อมูลหอพักและที่พักอาลัย

- แผ่นข้อมูลร้านค้าโดยรอบหอพัก

- แผ่นข้อมูลสถานที่อื่นๆ

- แผ่นข้อมูลป้ายรถประจำทาง

- แผ่นข้อมูลทางคมนาคม

- แผ่นข้อมูลภาพถ่ายทางอากาศ

5.1.3 โปรแกรมประยุกต์

โปรแกรมประยุกต์สารลนเทศทางภูมิศาสตร์เพื่อการตัดสินใจหาที่พักอาลัย เป็นการนำ

โปรแกรม ArcMap ซึ่งเป็ส่วนหนึ่งของโปรแกรม ArcView 8.3 มาพัฒนาด้วยภาษา Visual Basic for 

application (VBA) ให้ผู้ใซ้สามารถค้นหาข้อมูลรวมถึงการนำเข้าและแก้ไขข้อมูลภายในฐานข้อมูล

โปรแกรมประยุกต์นี้เน้นการพัฒนาให้ผู้ใช้สามารถนำโปรแกรมไปใช้ได้อย่างสะดวกและง่ายฃึ้นกว่าการ 

ใช้โปรแกรมทางภูมิศาสตร์โดยตรง

โปรแกรมประยุกต์นี้สามารถเป็นเครื่องมือช่วยการตัดสินใจและใช้ประโยชน์ในงานด้าน 

หอพักหรือที่พักอาลัยสำหร้บนิสิตน์กศกษาอีกทั้งผู้ที่เกี่ยวข้องหรือลนใจในงานด้านนี้ ซ่ึงลามารถนำ

ข้อมูลในการวิจัยนี้ไปใช้ประโยชน์ในการวางแผนและวิเคราะห์เกี่ยวกับหอพักหรือที่พักต่อไป เช่น การ 

เลือกที่ตั้งหอพักใหม่ การปรับปรุงด้านราคาหรือสิ่งอำนวยความสะดวกเพื่อยกระดับหอพักให้ทัดเทียม 

กับหอพักอื่นๆ เป็นต้น
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ภาพที่ 5.1 หน้าจอรองโปรแกรม ArcMap ในโปรแกรม Arcview 8.3

ภาพที่ 5.1 หน้าจอรองโปรแกรมประยุกต์สารสนเทศภูมิศาสตร์เพื่อการตัดสินใจหาที่พักอาตัย

5.1.3.1 ผลการพัฒนาโปรแกรม

การพัฒนาโปรแกรมนี้รวมถึงการพัฒนาหน้าจอและการทำงานรองโปรแกรม 

สารสนเทศให้มีรูปแบบการใช้งานที่ง่ายขึ้นสำหรับผู้ใช้งานที่ไม่มิพื้นความรู้ทางด้านภูมิศาสตร์ 

โปรแกรมมีการทำงานตังนี้
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1 ) การสอบถามข้อมูล โดยแบ่งการค้นหาแบ่งออกเป็น 2  แบบ คือ

- การสอบถามข้อมูลแบบหลายเงื่อนไข : การค้นหาหอพัก

- การสอบถามข้อมูลแบบเงื่อนไขเดียว : การค้นข้อมูลอื่นๆ และ การค้นหา

หอพักและข้อมูลอื่นๆ

2 ) การแก้ไขข้อมูล

- การเพิ่มข้อมูล

- การลบข้อมูล

- การย้ายข้อมูล

- การแก้ไขรายละเอียดของข้อมูล

3) การแสดงผล

4) การส่งออกข้อมูล

5.1.3.2 ผลลัพธ์ที่ได้จากโปรแกรมประยุกต์ สามารถสรุปได้ ดังนี้

1 ) ผลจากการลอบถาม

ผู้ใช้สามารถค้นหาที่พักและสถานที่สำคัญได้ด้วยการเลือกเงื่อนไขการค้นหา 

ได้ด้วยคัวเอง โดยโปรแกรมได้ถูกออกแบบไห้การสอบถามข้อมูลอยู่รูปของแบบฟอร์มที่เข้าไจง่าย

เพียงการเลือกเงื่อนไขจากกล่องรายการที่มีเตรียมรายการไว้แล้วและการใส่คำสำคัญเพิ่มเดิม 

โปรแกรมจะทำการค้นหาสถานที่ที่ต้องการให้ผู้ใช้ทันที ถ้าเงื่อนไขไม่ถูกต้องจะมีข้อความปรากฏเป็น

การแจ้งเตือนผู้ใช้

2 ) ผลจากการนำเข้าและแก้ไขปรับปรุง

ผู้ใช้สามารถนำเข้า แก้ไข และปรับปรุงข้อมูลในฐานข้อมูลทั้งฐานข้อมูล

กราพิกและข้อมูลตามลักษณะให้เป็นปัจจุบันได้อย่างสะดวก ด้วยการใช้ชุดเครื่องมีอและใ]มคำลังใน 

เมนูที่ผู้วลัยได้ออกแบบไวโดยลดความซับช้อนของโปรแกรมเดิมลง เพื่อให้ผู้ใช้ลามารถเข้าใจและใช้ได้ 

ง่ายขึ้น

3) ผลจากการแสดงผล

เป็นการแสดงผลจากหน้าจอคอมพิวเตอร์ทั้งข้อมูลกราพิกและข้อมูลตาม 

ลักษณะ โปรแกรมถูกออกแบบให้มีการเปลี่ยนสีข้อมูลกราพิกจากเดิมเป็นสีฟ้าเมื่อมีการกระทำจาก

ผู้ใช้ ทำให้ผู้ใช้ทราบว่าข้อมูลใดกำลังทำงานอยู่ ส่วนข้อมูลตามลักษณะจะอยู่ในรูปของแบบฟอร์ม

การแสดงผลอย่างง่ายๆ โดยโปรแกรมจะรับค่าจากการเลือกสถานที่ของผู้ใช้ที่หน้าจอคอมพิวเตอร์แล้ว 

จะทำการค้นคืนกายในฐานข้อมูลและแสดงรายละเอียดของข้อมูลนั้น
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4) ผลจากการส่งออกรายงาน

ผู้ใซ้ลามารถเสือกส่งออกรายงานข้อมูลกราฟิกหรือแผนที่ ผู้ใข้เพยงกำหนด

ขนาดโดยการย่อชยายแผนที่แล้วเลือกออกเมนูแผนที่ แผนที่ที่ผู้ใช้กำหนดจะไปปรากฏในแม่แบบที่ได้ 

มีการออกแบบเตรียมไว้ล่วงหน้าแล้ว และข้อมูลตามลักษณะที่สามารถเสือกการออกรายงานได้จาก

หลายวิธีทั้งจากผลการค้นหาหรือการเสือกชื่อจากกล่องรายการ แสดงผลเป็นตารางรายละเอียด

ทั้งหมดของหอพักและสถานที่นั้น

การเปรียบเทียบกา?ทำงานของโปรแกรมดั้งเดิมและโปรแกรมประยุกต์

โป ร แ ก ร ม  Arcview โป ร แ ก ร ม ป ร ะ ย ุก ต ์ (โปรแกรม Arcview + VBA)

1 . การค้นหาสถานที่

- เพิ่มชั้นข้อมูลที่ต้องการเข้าไปในโปรแกรม

- จากนั้นเสือกรายการ selection > Select 

By Attribute > จะมีแบบฟอร์มให้ผู้ใข้เลือก 

กำหนด โดยต้องกำหนด 1) ชั้นข้อมูล (Layer) 

2) เลือกวิธีค้นหา (Method) 3) เขตข้อมูล 

(Field) 4) ค่า Unique value เพื่อนำมาเขยน 

คำลัง SQL ในการสอบถามข้อมูล เซ่น

"M IN PRICE” >=2500 AND “MINPRICE” 

<= 8000 AND " TYPE = "หญิง" เพื่อหา 

หอพักหญิงราคาอยู่ระหว่าง 2500 - 8000 > 

เลือก Apply เพื่อทำการค้นหา

1 . การค้นหาสถานที่

- เสือกรายการค้นหา > หอพัก > มี 

แบบฟอร์มให้กำหนดเงื่อนไขเสือกตัวแปรที่ 

ต้องการ เซ่น ราคา ผู้ใช้ใส่เพียงแค่ตัวเลขราคาที่ 

ต้องการในซ่องราคาเท่านั้น > เสือกปมค้นหา 

เพื่อทำการค้นหา

2 . แก้ไขข้อมูล

การแก้ไขข้อมูลในโปรแกรมผู้ใข้จะต้องเพิ่มชั้น 

ข้อมูลกราฟิกนั้นเข้าไปในโปรแกรมเองก่อน แล้ว 

จึงจะสามารถแก้ไขข้อมูลนั้นต่อไปได้ โดยการ 

เลือกที่เครื่องมือ ■̂ - > เสือกสารบบ (Directory) 

ของข้อมูล > เลือกแฟ้มข้อมูล เซ่น Dorm.shp > 

ADD เพื่อเพิ่มชั้นข้อมูล

2 . แก้ไขข้อมูล

โปรแกรมประยุกต์ได้เพิ่มชั้นข้อมูลที่จำเป็น 

สำหรับผู้ใช้ไว้แล้ว จึงไม่ต้องเพิ่มชั้นข้อมูลนั้น 

ก่อนจะแก้ไขและจะมีภาพถ่ายทางอากาศแสดง 

เป็นพื้นหลัง เพื่อไว้ใช้ในการแก้ไขให้ถูกต้องตรง 

กับความจริงมากที่ลุด
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2 .1  การเพิ่มข้อมูล 2.1 การเพิ่มข้อมูล

- เพิ่มชั้นข้อมูลที่ต้องการเข้าไปใน 'ทำ'ได้ 2  ว ิธ ีค ือ  1 ) เลือกรายการตาม

โปรแกรม ซื่อข้อมูลที่ต้องการเพิ่ม เช่น หอพัก > รายการ

- เลือกรายการ Tool > Editor Toolbar > เพิ่ม 2 ) เลือกเครื่องมือเพิ่มหอพัก *

จะปรากฏแถบเครื่องมือ > เลือกรายกๆร Editor > เลือกตำแหน่งที่ต้องการเพิ่มบนหน้าจอ >

> Start Editing > เลือกลารบบ (Directory) ของ ปรากฏแบบฟอร์มให้ผู้ใซ้ใส่รายละเอียด ซึ่งผู้วิจัย

ข้อมูล > กำหนดชั้นข้อมูลที่ต้องการจะเพิ่มที่ ได้เลือกเฉพาะเขตข้อมูล (Field) ที่จำเป็นลำหรับ

รายการเลือก Target > กำหนดประนาทการ ผู้ใช้เท่านั้นและได้ออกแบบให้รูปแบบที่ง่ายขึ้น >

ทำงานที Task > Create New Feature > เลือก เลือกขุ่เมตกลงเพื่อยืนยันการเพิ่มและบันทึก

เครื่องมือ Sketch Tool &  (ประ๓ ทเครื่องมือ 

อย่างหนึ่ง) > เลือกตำแหน่งที่ต้องการเพิ่มบน

ข้อมูล

หน้าจอ > เลือกรายการเลือก Attribute > มื 2 .2  การลบข้อมูลกราฟก

ตารางปรากฏให้ใส่ข้อมูลในสดมภ์ (Column) - ทำได้ 2  ว ิธ ีค ือ  1 ) เลือกรายการตาม

Property จะแสดงรายซื่อเขตข้อมูล (Field) ซื่อข้อมูลที่ต้องการลบ เช่น หอพัก > รายการลบ

ทั้งหมดที่มืในชั้นข้อมูลนั้น และลดมภ ์ Value ให้

ผู้ใข้ใส่ค่าตามเขตข้อมูลที่ต้องการ > Save Edits 2 ) เลือกเครื่องมือลบหอพัก S3

เพื่อบันทึกข้อมูล > Stop Editing > เลือกตำแหน่งที่ต้องการเพิ่มบนหน้าจอ >

2 .2  การลบข้อมูลกราฟิก
เลือกปมตกลงเพื่อยืนยันการลบและบันทึกข้อมูล

- เพิ่มชั้นข้อมูลที่ต้องการเข้าไปใน 2.3 การย้ายข้อมูลกราฟิก

โปรแกรม 'ทำ,ได้ 2 ว ิธ ีค ือ  1 ) เลือกรายการ

- เลือกรายการ Tool > Editor Toolbar > ตามซื่อข้อมูลที่ต้องการย้าย เช่น หอพัก >

จะปรากฏแถบเครื่องมือ > เลือกรายการ Editor รายการย้าย •

> Start Editing > เลือกลารบ'บ (Directory) รอง 2 ) เลือกเครื่องมือลบหอพัก *

ข้อมูล > กำหนดชั้นข้อมูลที่ต้องการจะเพิ่มที่ > เลือกจุดที่ตั้งต้องการย้ายบนหน้าจอ > เลือก

รายการเลือก Target > เลือกเครื่องมือ Edit Tool ตำแหน่งใหม่ที่ต้องการย้าย

^  > เลือกตำแหน่งที่ต้องการลบบนหน้าจอ > 

เลือกรายการเลือก Edit > เลือก Delete หรือ 2.4 การแก้ไขลักษณะประจำ

เลือกเครื่องมือ Deletedชุดเครื่องมือ > Save 'ทำได ้ 2 ว ิธ ีค ือ  1 ) เลือกรายการ

Edits เพื่อบันทึกข้อมูล > Stop Editing ตามซื่อข้อมูลที่ต้องการแก้ไข เช่น หอพัก >
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2.3 การย้ายข้อมูลกราฟิก รายการแก้ไข Q

- เพิ่มชั้นข้อมูลที่ต้องการเข้าไปใน 2 ) เลือกเครื่องมือเพิ่มหอพัก ไ^

โปรแกรม > เลือกตำแหน่งที่ต้องการแก้ไขบนหน้าจอ >

- เลือกรายการ Tool > Editor Toolbar ปรากฏแบบฟอร์มให้ผู้ไซ้แก้ไขรายละเอียด ซ่ึง

> จะปรากฏแถบเครื่องมือ > เลือกรายการ Editor ผู้วิจัยได้เลือกเฉพาะเขตข้อมูล (Field) ที่สำคัญ

> Start Editing > เลือกสารบบ (Directory) ของ เท่านั้นและได้ออกแบบให้รูปแบบที่ง่ายขึ้น >

ข้อมูล > กำหนดชั้นข้อมูลที่ต้องการจะเพิ่มที่ เลือกปุมตกลงเพื่อยืนยันการแก้ไขและบันทึก

รายการเลือก Target > เลือกเครองมือ Edit Tool ข้อมูล

^  > เลือกตำแหน่งที่ต้องการย้ายบนหน้าจอ >

คลิกเมาส์ชายค้างที่จุดนั้นแล้วลากไปยังตำแหน่ง 3. แสดงผลข้อมูล

ใหม่ที่ต้องการ > Save Edits เพื่อบันทึกข้อมูล > 3.1 ข ้อมูลตามลักษณะ

Stop Editing - เลือกเครื่องมือตามซื่อข้อมูลที่ต้องการ

ทราบรายละเอียด เช่น แสดงรายละเอียดหอพัก

2.4 การแก้ไขลักษณะประจำ 0 > เลือกตำแหน่งที่ต้องการทราบ

- เพิ่มชั้นข้อมูลที่ต้องการเข้าไปใน รายละเอียดบนหน้าจอ > ปรากฏแบบฟอร์มที่

โปรแกรม แสดงรายละเอียด ซึ่งผู้วิจัยได้เลือกเฉพาะเขต

- เลือกรายการ Tool > Editor Toolbar > ข้อมูล (Field) ที่จำเป็นสำหร้บผู้ใซ้ที่ต้องรู้เท่านั้น

จะปรากฏแถบเครื่องมือ > เลือกรายการ Editor 3.2 ข้อมูลกราฟิก

> Start Editing > เลือกลารบบ (Directory) ของ โปรแกรมประยุกต์ได้เพิ่มชั้นข้อมูลที่มีความ

ข้อมูล > กำหนดชั้นข้อมูลที่ต้องการจะเพิ่มที่ จำเป็นสำหรับผู้ไซ้ในการคัดสินใจเลือกหอพักไว้

รายการเลือก Target > เลือกเครื่องมือ Edit Tool แล้ว

^  > เลือกตำแหน่งที่ต้องการแก้ไขบนหน้าจอ

> เลือกรายการเลือก Attribute > มืตาราง

ปรากฏให้ใส่ข้อมูลในสดมภ์ (Column) Property

จะแสดงรายซื่อเขตข้อมูล (Field) ทั้งหมดที่มืใน

ชั้นข้อมูลนั้น และสดมภ ์Value ให้ผูใช้แก้ไขค่า

ตามเขตข้อมูลที่ต้องการ > Save Edits เพื่อ

บันทึกข้อมูล > Stop Editing
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3. แสดงผลข้อมูล

3.1 ข้อมูลตามลักษณะ

- เพิ่มชั้นข้อมูลที่ต้องการเข้าไปใน 

โปรแกรม

- เลือกเครืองมือ Identify ©  > เลือก 

ตำแหน่งที่ต้องการทราบรายละเอียดบนหน้าจอ 

> ปรากฏตาราง Identify Results ประกอบด้วย 

สดมภ ์ (Column) Property จะแสดงรายซือเขต 

ข้อมูล (Field) ทั้งหมดที่มืในชั้นข้อมูลนั้น และ 

สดมภ ์ Value จะแสดงรายละเอียดข้อมูล

3.2 ข้อมูลกราทิเก

- การแสดงข้อมูลกราฟ้กใดๆ ผู้ใช้,จะต้อง 

เพิ่มชั้นข้อมูลที่ต้องการเข้าไปในโปรแกรมเองโดย 

เลือกที่เค่รื่องมือ > เลือกสารบบ (Directory) 

ของข้อมูล > เลือกแฟ้มข้อมูล เช่น Dorm.shp > 

ADD เพื่อเพิ่มชั้นข้อมูล

4. การส่งออก

4.1 ข้อมูลตามลักษณะ

- เพิ่มชั้นข้อมูลที่ต้องการเข้าไปใน 

โปรแกรม

- ที่ส่วนแสดงชั้นข้อมูล (Layer)!1ห้เลือก 

ชั้นข้อมูลที่ต้องการแสดงผล เช่น หอพัก > คลิก 

เมาลัฃวา > เลือกรายการ Open Attribute Table 

> จะปรากฏตาราง Attribute of Dorm ซึ่งจะมื 

สดมภ ์ (Column) Property จะแสดงรายซื่อเขต 

ข้อมูล (Field) ทั้งหมดที่มีในชั้นข้อมูลนั้น และ 

แถว (Row) จะแสดงรายละเอียดข้อมูลทั้งหมด >

4. การส่งออก

4.1 ข้อมูลตามลักษณะ

- รายการเลือกรายงาน > ออกรายงาน > 

ปรากฏแบบฟอร์มรายชื่อหอพักให้เลือกรายซื่อ 

หอพักที่ต้องการกี่แห่งก็ได้แล้วแต่ผู้ใช้จะกำหนด

> เลือกปมออกรายงาน > จะมืแบบฟอร์มที่ 

แสดงรายละเอียดที่สำคัญของหอพักที่ทั้งหมดที่ 

ผู้ใช้เลือก ในรูปของแบบฟอร์ม Crystal Report

> เลือก «แ เพื่อส่งออกข้อมูลเป็นสำเนาแสดงผล 

(Hard copy) และลามารถบันทึกเป็นแฟ้มข้อมูล 

ได้ด้วย
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เลือกข้อมูลที่ต้องการ > รายการเลือก Option 

ในตาราง Attribute of Dorm > เลือก Export > 

แบบฟอร์ม Export Data > เลือก All Records 

Record ซึง Selected Record จะต้องใช้การ 

ค้นหา ถ้าผู้ใช้ต้องการส่งออกข้อมูลหอพัก 

หลายๆ แห่งพร้อมกัน คือ

การเลือกรายการ Option ในตาราง 

Attribute of Dorm > Select By Attributes > 

จะมีแบบฟอร์มให้ผู้ใช้เลือกกำหนด โดยต้อง 

กำหนด 1) ชั้นข้อมูล (Layer) 2) เลือกวิธีค้นหา 

(Method) 3) เฃตข้อมูล (Field) 4) ค่า Unique 

value เพื่อนำมาเขียนคำลัง SQL ในการ 

สอบถามข้อมูล เช่น "NAME” = “ราชาวดี” 

AND “NAME" = “บ้านปทุมวัน" AND " 

"NAME" = “พญาไทอพาร์ทเมนท์" เพื่อกำหนด 

รายซื่อหอพักที่ต้องการเลือกส่งออก จากนั้น 

> เลือกลารบบ (Directory) ที่ต้องการส่งออก 

ข้อมูลที่ Output Table > OK เพื่อบันทึกเป็น 

แฟ้มข้อมูล

4.2 ข้อมูลกราฟ้ก

- เพิ่มชั้นข้อมูลที่ต้องการเข้าไปใน 

โปรแกรม

- เลือกชั้นข้อมูล ขนาด และลักษณะ 

ข้อมูลกราฟก > เลือกรายการเลือก View > 

รายการเลือก Layout View > จะปรากฏแผนที่ซึ่ง 

ไม่มีการแลดงรายละเอียดอื่นๆ ถ้าผู้ใช้ต้องการ 

เพิ่มรายละเอียดอื่นๆ เช่น มาตราส่วน

4.2 ข้อมูลกราฟก

- ผู้ใช้กำหนด1ช้ัน'ข้อมูล ขนาด และ 

ลักษณะของข้อมูลกราฟก > รายการเลือก 

รายงาน > แผนท่ี > แผ่นแบบ (Template) ซ่ึง 

ผู้วิจัยได้ออกแบบไว้ให้มีการแสดงมาตราส่วน 

ทิศ ลัญลักษณะในแผนที่ มาตราส่วนรูปแท่ง 

(Bar Scale) > เลือกแฟ้มข้อมูล > ส่งออกแผน 

ท ี่^  > เลือกสารบบ (Directory) > ต้ังซ่ือ 

แฟ้มข้อมูล เพื่อบันทึกเป็นลำเนาอิเล็กทรอนํกลั 

(Soft copy) หรือ > เลือก Ü  เพื่อส่งออกเป็น 

ลำเนาแสดงผล (Hard copy )
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กัญลักษณะ ผู้ใช้ต้องใสเพิ่มเอง โดยการเลือก 

รายการเลือก Insert > Legend > จะมี 

แบบฟอร์ม Legend Wizard ให้เลือกชันข้อมูลที่ 

ต้องการแลดง กัญลักษณ์แทนข้อมูลนั้นในแผนที่ 

และชั้นตอนต่าง > เลือก File > Export Map 

^  > เลือกสารบบ (Directory) > ต้ังช่ือ 

แฟ้มข้อมูล เพื่อบันทึกเป็นสำเนาอิเล็กทรอนิกกั 

(Soft copy) หริ1อ > เลือก Ü  เพื่อส่งออกเป็น 

สำเนาแลดงผล (Hard copy )

5. Help

อธิบายการใช้งานและการทำงานของโปรแกรม 

ประยุกต์ทั้งหมดเป็นภาษาอังกฤษ

5. Help

อธิบายการใช้งานและการทำงานของ 

โปรแกรมประยุกต์ทั้งหมดเป็นภาษาไทย

6 . ส่วนการแสดงผล

ผู้วิจัยได้เลือกชั้นข้อมูลที่เห็นว่ามีความ 

สำคัญต่อการตัดสินใจเลือกหอพักไว้แล้ว 7 ช้ัน 

ข้อมูล

5.2 การ่วิเคราะห์การดำเนินการวิจัย

5.2.1 ข้อมูลที่ใช้ในการดำเนินการวิจัย

5.2.1.1 ข้อมูลกราฟิก ผู้วิจัยได้จัดทำข้อมูลกราฟิกขึ้นใหม่และมีการนำแผนที่เชิงเลข 

มาตราส่วน 1:20000  ได้รับการอนุเคราะห์จากคูนย์ข้อมูลกรุงเทพมหานคร กองลารลนเทศภูมิคาลตร์ 

สำนักนโยบายและแผนกกรุงเทพมหานคร มาปรับปรุงแก้ไขเพิ่มเติมเพื่อใช้เป็นแผนที่ฐาน (Base map)

(1 ) ข้อมูลกราฟิกที่จัดทำใหม่

-ชั้นข้อมูลที่พ ักอาศัย ซึ่งจะรวมถึง หอพัก ห้องชุด อาคารชุด บ้าน 

เช่า ฯลฯ จากการเก็บข้อมูลภาคสนามมีจำนวนทั้งสิน 84 แห่ง

- ช ั้นข ้อมูลร้านค้าและบริการรอบที่พ ัก จะเป ็นร ้านค ้าและบร ิการท ี่ 

เกี่ยวข้องกับผู้ใช้บริการหอพักในบริเวณรอบที่พักอาศัย เช่น ร้านอาหาร ร้านขายขาย ร้านซักริด ร้าน 

ละดวกซื้อเป็นต้น รวม 188 แห่ง
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- ชั้นข้อมูลทางคมนาคม ถนนสายหลัก

(2 ) ข ้อม ูลกราฟ ิกท ี่นำมาปรับปรุงแก ้ไขเพ ิ่มเต ิม เพ ื่อให้ตรงกับความ

ต้องการของงานวิจัย

กา?รวมข้อมูล เป ็นการนำข้อมูลจากชั้นข้อมูลมารวมกันให้เป็นชั้น 

ข้อมูลใหม่ที่มีเฉพาะข้อมูลตามที่งานวิจัยนี้ต้องการ ดังนี้

- ชั้นข้อมูลทางคมนาคม เป็นการรวมข้อมูลถนนย่อย ซอย ทาง

รถใฟ ทางด่วนและทางรถไฟฟ้า BTS

- ช ั้นข ้อมูลสถานที่สำค ัญ เป ็นการรวมข ้อม ูลต ่างๆ เช่น ธนาคาร 

โรงพยาบาล สถานศึกษา สถานที่ราชการ คาสนสถานฯลฯ

แก้ไขเพิ่ม ในชั้นข้อมูลเซิงแผนที่บางชั้นข้อมูลม่ข้อมูลไม่ครบหรือไม่ 

ปรากฏในแผนที่ข้อมูลเซิงเลข จึงต้องทำการแก้ไขเพิ่มเติม คือ

- ชั้นข้อมูลถนน ถนนย่อยและซอยบางแห่งที่ไม่ปรากฏในแผนที่ 

ข้อมูลเซิงเลข ได้ทำการการติจิไทซ์เพิ่มเติมต่อจากถนนและซอยหลัก และได้ทำการแก้ไขทางด้าน 

กราฟิกเพิ่มเติมด้วย

- ช ั้นข้อมูลจุดสำคัญ ได้ติจิไทซ์เพิ่มตำแหน่งของสถานที่เห็นว่ามี 

ความน่าสนใจสำหรับผู้ใซ้แผนที่ของงานวิจัยนี้

- ชั้นข้อมูลขอบเขต เนึ่องจากขอบเขตการศึกษาของการวิจัยนี้อยู่ 

ในพื้นที่ของเขต 2  เขต ได้แก่ เขตปทุมวัน และเขตราชเทวิ แต่แผนที่ข้อมูลเซิงเลขที่ได้มาเป็นแผน 

ที่กรุงเทพมหานคร จึงต้องคัดข้อมูลเฉพาะแผนที่ของ 2  เขตออกมา ซึ่งขอบเขตของพื้นที่ศึกษาส่วน 

ใหญ่'จะอยู่'ในเขตปทุมวัน ส่วนในเขตราชเทวิได้ทำการคัดเฉพาะพื้นที่ที่อยู่ในขอบเขตการศึกษาเท่านั้น 

จากนั้นทำการรวมแผนที่ของพื้นที่ทั้ง 2  ส่วนเข้าด้วยกันให้เป็นแผนที่เดยว

การจัดทำข้อมูลกราฟิกข้างต้นมีข้อดและข้อเลยคังนี้

ข้อติ

1 ) แผนที่เซิงเลขที่ได้สามารถนำมาใช้ประโยชน์ในงานวิจัยครั้งนี้ได้ โดยเลือก 

เฉพาะข้อมูลที่เกี่ยวข้องกับการค้นหาที่พักอาศัยที่มีอยู่ในแผนที่เซิงเลขมาปรับปรุงแก้ไขเพิ่มเติม

2 ) สามารถลดระยะเวลาในการจัดทำแผนที่ฐาน

ข้อเลีย

1 ) แผนที่เซิงเลขที่ได้รับยังไม่มีการปรับปรุงข้อมูลให้ทันสมัยเป็นปัจจุบัน เนื่องจาก 

เป็นข้อมูลในปี 2541 ผู้วิจัยจึงต้องทำการแก้ไขข้อมูลเพิ่มเติมโดยการออกสำรวจภาคสนาม

2 ) แผนที่เซิงเลขที่ได้รับมาผู้วิจัยจำเป็นต้องทำการตรวจลอบและปรับปรุงแก้ไขความ 

ถูกต้องทางระบบยูทีเอ็มอกครั้งเพื่อความถูกต้องในการนำไปใช้
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3) โครงลร้างฐานข้อมูลของข้อมูลที่ได้รับมานั้นยังไม่ตรงกับความต้องการในการ 

ดำเนินการวิจัยครั้งนี้ จึงต้องปรับปรุงโครงสร้างฐานข้อมูลไหม่ให้ต้องกับความต้องการของงาน 

ว ิจ ัยน ี้ เซ่น การลร้างและกำหนดขอบเขตข้อมูลใหม่ การผสาน (Merge) แผ่นข้อมูล และการวาง 

ช้อน (Overlay ) แผ่นข้อมูล เป็นต้น

4) เมื่อนำแผนที่เชิงเลขที่ไต้มา มาวางช้อนกับภาพถ่ายทางอากาศที่ผู้วิจัยจัดทำขึ้น 

เนื่องจากมีมาตราส่วนและระบบพิกัดที่แตกต่างกันจึงทำให้ต้องทำการแก้ไขปรับความคาดเคลื่อนใหม่ 

ให้สามารถวางช้อนกันไต้พอดี

5 .2 .1 .2  ข ้อมูลตามลักษณะ

ผู้วิจัยไต้ใช้โปรแกรม ArcView 8.3 ในการจัดทำฐานข้อมูลตามลักษณะซึ่ง 

เป็นโปรแกรมที่มีการจัดการฐานข้อมูลในตัวโปรแกรมเอง ผู้วิจัยไต้รวบรวมข้อมูลที่จำเป็นในการ

ดำเนินงานการตัดสินใจหาที่พักอาลัยสำหรับนิสิตนักศึกษา โดยการนำข้อมูลที่ไต้มาศึกษาปรับปรุง

แก้ไขและออกภาคสนามเก็บข้อมูลเพมเติม เพื่อนำมาออกแบบฐานข้อมูลใหม่ให้ตรงกับการดำเนิน

งานวิจัยครั้งนี้มากที่สุด ซึ่งจะเน้นการออกแบบให้ตอบสนองกับโปรแกรมการค้นหาหอพักเพื่อความ

สะดวกในการติดต่อและค้นหาข้อมูลในการประมวลผลของโปรแกรมต่อไป ในการรวบรวมข้อมูล

และการจัดทำเน้นไปที่การเก็บรวบรวบและการจัดทำข้อมูลหอพักและที่พักอาลัยสำหรับนิสิตนักศึกษา 

เป็นหลัก ซึ่งผู้ว ิจัยไต้ออกแบบและจัดทำแบบฟอร์มในการจัดเก็บข้อมูลตามลักษณะ โดยผู้วิจัยไต้นำ 

แบบฟอร์มออกไปลอบถามรายละเอยดต่างๆ เกี่ยวกับที่พักอาลัยในพื้นที่ศึกษา เพื่อนำข้อมูลที่ไต้ไป

สร้างเป็นฐานข้อมูลตามลักษณะในโปรแกรมประยุกต์เพื่อการค้นหาที่พักอาลัยของนิสิตนักศึกษา

5.3 ข้อเสนอแนะ

โปรแกรมประยุกต์นี้ผู้วิจัยไต้ทำการพัฒนาให้ลามารถจัดการข้อมูลกราพิณเละข้อมูลตาม 

ลักษณะและแสดงผลร่วมกันผ่านทางหน้าจอคอมพิวเตอร์เพื่อการตัดสินใจเลือกที่พักอาลัยของนิสิต 

นักศึกษา โปรแกรมประยุกต์นี้เป็นโปรแกรมต้นแบบซึ่งน่าจะมีการพัฒนาให้ผู้ใช้เก็ดความสะดวกต่อ

การใช้มากขึ้น

1 ) การใช้ข้อมูลกราพิกที่ผู้วิจัยนำมาใช้เป็นข้อมูลเชิงเลขมาตราส่วน 1 : 20000 ซึ่งแสดงที่ตั้ง 

หอพักและสถานที่ต่างๆในลักษณะจุด (Point) ของที่ตั้ง หากเป็นไปไต้น่าจะมีการพัฒนานำที่ตั้งสถาน 

ที่มาออกแบบให้เป็นการแสดงในลักษณะรูปหลายเหลี่ยม (Polygon) เพื่อเพิ่มความละเอียดของข้อมูล 

ขึ้นอีก เซ่น การแสดงอาคารในแผนที่โดยใช้แสดงในลักษณะรูปหลายเหลี่ยม (Polygon) แทนข้อมูล 

จุด
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2 ) การค้นคืนข้อมูลตามเงื่อนไขต่างๆ ที่ผู้วิจัยออกแบบและสร้างขึ้นในการตัดสินใจหาที่พัก 

อาลัยสำหรับนํสิตนักศึกษา เช่น ราคา ที่ตั้ง ระยะห่างจากมหาวิทยาลัย ในการพัฒนาการค้นหาที่ 

พักต่อไปน่าจะมีการนำเงื่อนไขอื่นๆ เข้ามาใข้เพื่อเพิ่มความหลากหลายในการค้นหาและตัดสินใจเลือก 

ที่พัก

3) ในการดำเน้นการวิจัยครั้งนี้ผู้วิจัยได้เลือกใช้โปรแกรมทางภูมิศาสตร์ Arc View 8.3 ใน

การพัฒนาโปรแกรมประยุกต์ ซึ่งเป็นโปรแกรมที่มีการจัดการฐานข้อมูลได้ทั้งข้อมูลกราขีเกและข้อมูล 

ตามลักษณะ โปรแกรมภูมิศาสตร์ในปัจจุบันมีมากมายหลายหลายโปรแกรมซึ่งน่าจะนำมาพัฒนา

เป็นโปรแกรมประยุกต์และนำมาจัดการก้บฐานข้อมูลในลักษณะนี้ต่อไปซึ่งอาจจะมีความลมบูรณ์ได้ 

มากยงขึ้น เช่น Maplnfo

4) ในการเขียนเพื่อพัฒนาโปรแกรมประยุกต์ผู้วิจัยได้ใช้โปรแกรม VBA ซึ่งเป็นโปรแกรมที่ใช้

พัฒนาโปรแกรม Arc View 8.3 เพื่อพัฒนาการทำงานและหน้าจอแสดงผล ซึ่งโปรแกรมที่สามารถ 

นำมาพัฒนาโปรแกรมทางภูมิศาสตร์ให้แยกโปรแกรมประยุกต์ออกจากโปรแกรมหลักได้ด้วย ซึ่งน่าจะ 

มีการนำมาพัฒนาต่อไป ขณะนี้ย้งมีอกหลายโปรแกรมที่สามารถนำมาใช้ในการพัฒนาได้อย่างเช่น

VisualBasic.net เป็นด้น

5) งานวิจัยครั้งนี้ได้เลือกหอพักรอบมหาวิทยาลัยเป็นกรณีศึกษา ซึ่งผู้วิจัยเห็นว่าน่าจะ 

ลามารถใช้ข้อมูลในด้านอื่นๆ มาประยุกตํใช้กับวิจัยนี้ได้ เช่น การหาพื้นที่สวนสาธารณะ
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